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Warranty 

All products manufactured by ICP DAS are under warranty 

regarding defective materials for a period of one year, 

beginning from the date of delivery to the original purchaser. 

Warning 

ICP DAS assumes no liability for any damage resulting from 

the use of this product. ICP DAS reserves the right to 

change this manual at any time without notice. The 

information furnished by ICP DAS is believed to be accurate 

and reliable. However, no responsibility is assumed by ICP 

DAS for its use, not for any infringements of patents or other 

rights of third parties resulting from its use. 

Copyright 

Copyright @ 2012 by ICP DAS Co., Ltd. All rights are 

reserved. 

Trademark 

The names used for identification only may be registered 

trademarks of their respective companies. 

 

Contact US 

 

If you have any problem, please feel free to contact us. 

You can count on us for quick response. 

 

   Email: service@icpdas.com 

mailto:service@icpdas.com
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1. Introduction 

 

ViewPAC is an innovative product by ICP DAS. It is a PAC which combines display, 

operation and control in one unit. ViewPAC provides perfect solutions to integrate 

HMI, data acquisition and control in one PAC. It overthrows traditional image that 

HMIs and controllers are working separately and solves many communication 

problems between HMIs and controllers. In the PAC development history of ICP 

DAS, ViewPAC family sets a milestone. 

ViewPAC family provides two CPU types (PXA270,80186), 3 OS solutions (WinCE 

5.0, MiniOS7) and several software development toolkits (C, VS .NET, ISaGRAF, 

InduSoft) for chosen, and all of them are featured same stability and flexibility as ICP 

DAS’s PAC family. This makes ViewPAC has a good potential to apply to factory 

automation, building automation, machine automation, manufacturing management, 

environment monitoring, etc. It overthrows traditional architectures of “HMI + PLC” or 

“HMI + PAC”, and let users has more and flexible options to configure their 

automation system. 
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1.1. Features 

MP-570W offers the most comprehensive configuration and remote system upgrade 

solutions to meet specific application requirements. The following list shows the 

hardware and software features designed to simplify installation, configuration and 

application. 

Software Features 

 Windows CE .Net 5.0 Inside 

 Easy Remote Maintenance via Ethernet 

1. FTP Server 

2. VCEP Software 

 Built-In OPC Server: NAPOPC_CE5 

1. An OPC Server for SCADA Software 

2. Integrates Local/Remote I/O Modules via RS-232/485 or Ethernet 

3. Provides Library for eVC, C#, or VB.NET 

4. Supports Modbus and DCON Protocols 

 Development Software 

Visual Studio.NET 2005/2008, and eVC 

 SDK/Demo Programs for C#, VB.NET & eVC 
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Hardware Features 

 PXA 270 CPU (32-bit & 520 MHz) 

 IP65 Compliant Front Panel 

 5.7” TFT LCD (5.7” LCD is with Touch Panel) 

 Rubber Keypad with 24/6 Keys 

 Audio with MIC-In and Line-Out 

 64-bit Hardware Serial Number for Software Protection 

 3 Slots for High Profile I/O Modules 

 Rich I/O Expansion Ability 

1. Ethernet 

2. RS-232/422/485 

3. FRnet 

4. CAN bus 

 Dual Battery Backup SRAM (512 KB) 

 One Ethernet Port 

 2 Serial Ports (RS-232, RS-485) 

 Operating Temperature: -20 ~ +70 °C 
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1.2. Specifications 

The table below summarizes the specifications. 

 

System Software 

OS Windows CE .NET 5.0 

.Net Compact Framework 2.0 

Embedded Service FTP server, Web server (supports VB script, 

JAVA script), Embedded SQL server 

SDK Provided Dll for eVC, Dll for Visual Studio.Net 

2005/2008 

CPU Module 

CPU PXA270 or compatible (32-bit and 520 MHz) 

SDRAM 128 MB 

Dual Battery Backup SRAM 512 KB (for 5 years data retention) 

Flash 96 MB (64 MB for OS image, 31 MB for 

built-in Flash disk, 1 MB for registry) 

EEPROM 16 KB (data retention: 40 years; 1,000,000 

erase/write cycles) 

Expansion Flash Memory microSD socket with one 1 GB microSD card 

(support up to 16 GB microSDHC card) 

RTC (Real Time Clock) Provide seconds, minutes, hours, date of week 

/month; month and year, valid from 1980 to 

2079 

64-bit Hardware Serial Number Yes 

Dual Watchdog Timer Yes (0.8 second) 

Rotary Switch Yes (0 ~ 9) 

I/O Expansion Slots 

Slot Number 3 (for high profile I-8K and I-87K modules 

only) 

Hot Swap *Will be available Yes (for high profile I-87K modules only) 

Communication Interface 

Ethernet Port RJ45 * 1, 10/100 Base-TX 

(Auto-negotiating, Auto MDI/MDIX, LED 

indicators) 
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USB 1.1 (host) 1 

COM0 Internal communication with the high profile 

I-87K series modules in slots 

COM2 RS-485 (D2+, D2-; self-tuner ASIC inside);  

2500 VDC isolated 

COM3 RS-232 (RxD, TxD, CTS, RTS, DSR, DTR, 

CD, RI and GND); Non-isolated 

Main Machine Interface 

LCD 5.7” TFT (Resolution 640 x 480) 

Touch Panel Yes 

Rubber Keypad 6 Keys 

Audio Microphone-In and Earphone-Out 

LED Indicators 3 Dual-Color LEDs (PWR, RUN, LAN1, L1, 

L2, L3; L1 ~ L3 for user programmable) 

Environmental 

Operating Temperature -20 ~ +70 °C 

Storage Temperature -30 ~ +80 °C 

Ambient Relative Humidity 5 ~ 90% RH, non-condensing 

Power 

Input Range +10 V ~ +30 VDC 

Isolation 1 kV 

Capacity 2.5 A, 5 V supply to I/O expansion slots 

Consumption 7.2 W (0.3 A @ 24 VDC) 

Mechanical 

Dimension (W x D x H) 182 mm x 158 mm x 125 mm 

Ingress Protection Front panel: IP65 

Installation Panel mounting 
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1.3. Overview 

MP-570W contains several interfaces and peripherals that can be integrated with 

external systems. Here is an overview of the components and its descriptions. The 

details of these items are as follows: 
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1. LED Indicators 

The MP-570W contains three LED indicators that are located on the top of the unit. 

 

 

 

 

 

 

 

 

 

 

 

The LED indicators can be used to indicate the power status, OS status and 

Link/Activity, and are described as follows: 

 

LED 

Indicator 
State (Color) Meaning 

L1/L2/L3 ON (Red) Controlled via a program 

 OFF Controlled via a program 

RUN ON (Green) The OS is on 

 Blink 
The System_disk is being formatted or 

defragmented 

PWR ON (Green) The Power is ON 

 OFF The Power is OFF 

LAN1 ON (Green) The Link is active 

 OFF The Link is inactive 

 Blink (Green) Network activity 
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2. LCM 

The LCM size is 5.7” 640 x 480. 

3. Keypad 

The F1 ~ F6 function keys are programmed by the user. 

4. Micro SD Socket 

The MP-570W also contains a Micro SD socket that can be used to increase memory 

capacity to 16 GB. 

5. Rotary Switch 

The Rotary Switch is an operating mode selector switch which 

provides seven functions related to the selection of the operating 

mode and authorization control for the MP-570W. 

For more information about the operating mode, please refer to 

“section 2.3. Configuring the Boot Mode” 

6. I/O Expansion Slots 

The MP-570W contains three I/O expansion slots that are used to serve in the local 

and remote expansion.  

7. Power Input and Frame Ground 

The MP-570W contains a power terminal that is used 

to provide power for its operation.  

The terminal block contains 3 pins and the pin 

assignments are as follows: 
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8. Waterproof Ethernet Port 

The MP-570W contains an Ethernet port that is waterproof to protect the device from 

external contaminants. 

9. COM2 (RS-485) 

The COM2 port provides a connection to external RS-485 

devices. The COM2 has 2 pins, as follows: 

Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 

bps 

Data Bits: 7, 8 

Parity: None, Even, Odd, Mark (Always 1), Space 

(Always 0) 

Stop Bits: 1, 2 

FIFO: 16 bytes 

10. COM3 (RS-232) 

The MP-570W offers one standard RS-232 serial 

communication interface port, COM3 (9-pin Sub-D plug 

connector), and it is located on the back of MP-570W. Refer to 

figure below for RS-232 port pin assignment. 

Port Type: Male 

Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps 

Data Bits: 5, 6, 7, 8 

Parity: None, Even, Odd, Mark (Always 1), Space (Always 0) 

Stop Bits: 1, 2 

FIFO: 16 bytes 
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Tips & Warnings 

The table below shows the data bit of each COM port and their 

corresponding stop bit. 

Word Length Number of Stop Bits 

5, 6, 7, 8 1 

5 1.5 

6, 7, 8 2 

 

 

11. USB Port 

The MP-570W contains a USB port that allows support for USB devices such as 

mouse, keyboard or an external USB hard drive.  

12. Microphone and Earphone Jacks 

The MP-570W contains a microphone and an earphone jack to allow the input and 

output of audio system. 
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1.4. Dimensions 

The diagrams below provide the dimensions to use in defining your enclosure 

specifications. Remember to leave room for potential expansion if you are using other 

components in your system. 

 

All dimensions in millimeter. 
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1.5. Companion CD 

This section describes the content of the companion CD, which provides the resource, 

tool kit, software and documentation related to the MP-570W. 

 

CD:\Napdos\vp-2000_ce50\ 

backup 

The backup files related to the documents, OS images, SDKs...., etc. 

Demo 

The demo programs for examples of use in the application. 

Document 

The technical support documents for installation, operation, 

maintenance, development and application. 

Micro_SD 

The tools and drivers related to manage the MP-570W 

OS_image 

The files and related information for OS releases and technology. 

PC_Tools 

The tools and utilies for operation with PC. 

SDK 

The sources for development and application in your application. 

System_Disk 

The tools and drivers related to System_Disk that install  on MP-570W  

Update 

The installation packages related to MP-570W 
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2. Getting Started 

This chapter provides a guided tour that describes the steps needed to download, 

install, configure, and run the basic procedures for user working with the MP-570W 

for the first time. 

Before starting any task, please check the package contents. If any of the following 

package contents are missing or damaged, contact your dealer, or distributor. 

 

In addition to this guide, the package includes the following items: 

 

 

 

 

MP-570W & Touch Pen    Expansion I/O Socket * 3 

 

 

 

 

Quick Start Guide  Software Utility CD  1 GB Micro SD Card 

 

 

 

 

RJ-45 Waterproofing Kit  Panel Clip * 4   Screw Driver 
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2.1. Mounting the Hardware 

Before you work with the MP-570W, you should have a basic understanding of 

hardware specification, such as the dimensions, the usable input-voltage range of the 

power supply, and the type of communication interfaces. 

For more information about the hardware details, see section 1.2., “Specifications.” 

For more information about the hardware dimensions, see section 1.4., “Dimension.” 

 

 

2.1.1. Removing the Slot Cover 

The MP-570W has a slot cover to protect the internal 

components from damage during shipping. Before 

starting any installation, please first remove the slot 

cover. 

 

 

 

Step 1: Hold the top of MP-570W 

 

 

 

Step 2: Pull the plastic wrap 

 

 

 

The slot cover has 

been removed 
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2.1.2. Installing Expansion I/O Sockets 

The case (a socket and a top case) is included in the 

package. Before inserting the I/O modules talling the I/O 

modules in  

If you do not expand the I/O module full, please keep the 

top case of the unused slot to protect the backplane from 

dirt, dust and damage from foreign objects. 

 

 

Step 1: Take the socket out from 

the case 

 

 

Step 2: Padlock the bottom of the socket into the 

MP-570W 

 

 

Step 3: Slide the socket into the 

MP-570W until it clicks 
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2.1.3. Inserting the I/O Modules 

MP-570W supports a complete range of I/O modules for interfacing many different 

field devices. 

For more information about I/O expansion modules, please refer to: 

http://www.icpdas.com/products/PAC/winpac/io_support_list.htm 

 

Step 1: Hold the I/O module vertically and align 

the socket 

 

Step 2: Carefully press the I/O module onto the 

socket 

 

Tips & Warnings 

If you do not expand the I/O module full, please keep the top case 

of the unused slot to protect the backplane from dirt, dust and 

damage from foreign objects. 

 

 

Step 3: Read the relevant documentation 

For high profile I-8K series:  

CD:\Napdos\io_module\ 

http://www.icpdas.com/products/PAC/winpac/io_support_list.htm 

For high profile I-87K series:  

CD:\Napdos\io_module\ 

http://www.icpdas.com/products/PAC/winpac/io_support_list.htm 

 

 

http://www.icpdas.com/products/PAC/winpac/io_support_list.htm
http://www.icpdas.com/products/PAC/winpac/io_support_list.htm
http://www.icpdas.com/products/PAC/winpac/io_support_list.htm
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Step 4 Wire the I/O channels 

All documents include the I/O module specifications, pin assignments and wiring 

connections. 

For example, Pin Assignments and Wiring connections for the I-87054W module are 

as follows: 

 

 

 

 

Tips & Warnings 

It is recommended that the power to the MP-570W is switched off 

when wring the I/O module which are plugging in the MP-570W 

slots. 
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2.1.4. Mounting the Waterproof 

The MP-570W is equipped with an IP65 waterproof connector to withstand 

contaminant in dusty environment and immersion in water and corrosive elements. 
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2.1.5. Mounting the MP-570W 

The MP-570W can be mounted on a panel of 

maximum thickness 12 mm. Adequate access space 

can be available at the rear of the instrument panel 

for wiring and servicing purposes. 

 

Tips & Warnings 

To ensure proper ventilation for your 

MP-570W, leave a minimum of 50mm 

space between the top and bottom 

edges of the MP-570W and the 

enclosure panels. 

 

 

Step 1: Prepare the panel and cut the 

hole to the specified size 

 

Step 2: Attach the MP-570W to the 

cut-out hole 
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Step 3: Insert the panel mounting clips into the upper and lower 

ventilation holes 

 

 

 

 

 

 

 

 

 

 

Step 4: Screw the panel mounting 

clips to the panel 
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2.1.6. Deploying a Basic MP-570W Application 

The MP-570W provides a variety of communication interface to suit a range of 

applications. Here is a simple application for using the MP-570W that is shown below. 

 

Step 1: Connect the positive terminal (+) of the power supply to the 

terminal PWR and the negative terminal (-) of the power supply 

to the P.GND 

Tips & Warnings 

The input range of power supply is +10 ~ +30 VDC 

 

 

Step 2: Connect PC to the Ethernet port 

Step 3: Connect the USB keyboard to the USB port 

Step 4: Connect the audio to the microphone and earphone jack 
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2.2. Installing the Tools and Utilities 

The MP-570W has several tools and utility that allows and supports you quickly and 

easily to manage the XP-8000-Atom-CE6. Here we will introduce two practical of 

them and guide you through the installation. 

 

Remote Display is one of the Windows CE operating system 

toolkits. If your MP-570W is connected to PC through the 

network, you can use this utility to display the device screen on 

the host PC and control the MP-570W remotely through this 

interface. 

For more information on how to use Remote Display to control the MP-570W 

remotely, please refer to section 2.6. Using Remote Display to Control the 

MP-570W Remotely 

 

 

DCON Utility is a toolkit that is designed to configure, manage 

and monitor the I/O modules from PC via COM port or Ethernet. 

For more information on how to use DCON Utility to configure the I/O module, 

please refer to section 2.7. Using DCON Utility to Configure the I/O Module. 

 

Step 1: Get the DCON Utility and Remote Display 

The DCON Utility and Remote Display can be installed from the CD that was 

provided with the package or by downloading the latest version from ICP DAS web 

site. 

CD:\Napdos\vp-2000_ce50\PC_Tools\ 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/pc_tools/ 

 

Step 2: Follow the prompts until the installation is complete 

 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/pc_tools/
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2.3. Configuring the Boot Mode 

The MP-570W has seven boot modes that can be determined through a rotary switch. 

 

The table below lists the operation mode selection. 

 
Position Modes of operation 

0 Normal mode (Default) 

1 Safe mode 

2 Debug mode 

3 OS update mode 

4 Development mode 

5 DCON_CE 

6 VCEP 

7 ~ 9 (For user) 

Normal Mode (Default) 

Normal mode is the default mode of operation and the one you will use most of the 

time. Use this mode for more tasks and configurations. Programs also are 

executed in this mode. 

Safe Mode 

Safe mode is a troubleshooting option that starts your computer with only basic 

services and functionality. If an existing problem does not reappear when you start 

MP-570W in safe mode, you can eliminate the default settings and basic device 

drivers as possible causes.  
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Tips & Warnings 

In normal mode, if the new settings are not saved when you 

change and save the settings using the ViewPAC_Utility, to solve 

this problem, perform the following steps: 
 

Step 1: Restart the MP-570W in safe mode 

Turn the rotary switch to “1”, and then restart the MP-570W. 

 

Step 2: Start the ViewPAC_Utility to 

restore the default settings 

Start the ViewPAC_Utility, and then click the 

“Restore Default Settings” command and “Save” 

command from the “File” menu 

 

 

 

Step 3: Restart the MP-570W in 

normal mode 

Turn the rotary switch to “0”, and then 

restart the MP-570W. 
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Debug Mode 

The debug mode is a function hidden in a program that provides options used for 

testing and debugging that are not available to users. 

Debug mode is unsupported. 

OS Update Mode 

OS update mode is a way that is used to update OS. To update the MP-570W OS 

image, please refer to “6.1. OS updates” 

DCON_CE Mode 

This mode is the same as Normal mode. Besides, DCON_CE.exe will be run 

automatically after booting 

 

Tips & Warnings 

DCON_CE.exe must be placed on the 

\System_Disk\Tools\DCON_CE, or else DCON_CE.exe cannot 

be run automatically after booting. 
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VCEP Mode 

This mode is the same as Normal mode. Besides, VCEP.exe will be run 

automatically after booting. 

 

Tips & Warnings 

VCEP.exe must be placed on the 

\System_Disk\Tools\VCEP or else VCEP.exe cannot be run 

automatically after booting. 

 

 

User Mode 

Rotary switch position 7, 8, 9 are reserved for user’s applications. 

When MP-570W is boot with one of these rotary switch positions, it is boot at 

normal mode. User’s application can check the rotary switch position to run at 

different mode. 
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2.4. Changing the User Interface Language 

The "Regional Settings" is a Windows CE functionality that allows users to easily 

change the MP-570W user interface to your native language. 

 

 

Step 1: Click Start menu, point to Settings, 

click Control Panel, and then click 

Regional Options 
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Step 2: Click User Interface Language 

tab, choose to your local 

language, and then click OK 

 

Step 3: Click OK, and then run the 

ViewPAC_Utility 

 

 

 

 

 

Step 4: Save and reboot the MP-570W 
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2.5. Testing the MP-570W 

ViewPAC combines WinPAC, graphic display and keypad dial in one unit. The 

ViewPAC_QuickTest is a toolkit used to check out the ViewPAC particular function 

compared with WinPAC. 

 

Audio Options: 

 

Play Audio button is used to check the audio 

output. 

Buzzer Options: 

 

Play Buzzer button is used to check the 

buzzer. 

 

LED Options: 

These buttons are used 

to check LEDs sign. 

KeyPAD Option: 

Checkboxes are used to 

check the KeyPAD. 

LCD Backlight 

Options: 

The slider is used to 

check the LCD Backlight. 
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2.6. Using ViewPAC_Utility to manage the MP-570W 

The ViewPAC_Utility is a collection of the ViewPAC system tool that allows user 

quickly and easily manage and configure the ViewPAC. 

For more detailed information on ViewPAC_Utility applications, please refer to “3.5. 

ViewPAC_Utility” 

 

Step 1: Run the ViewPAC_Utility located on desktop 

 

 

Step 2: Configure IP address 

(DHCP), FTP Server, Auto 

Execution files…, etc 

 

 

 

 

Step 3: Save and Reboot the 

MP-570W 
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2.7. Using DCON Utility to Configure the I/O Modules 

The DCON Utility is a client utility that runs on PC, and communicates with MP-570W 

via DCON protocol. The DCON Utility allows users to remotely connect to I-7K and 

I-87K series I/O modules for management through the COM port and Ethernet port. 

This tool is composed of two parts, a client and a server. The server is a program 

named DCON_CE_WP.exe running on MP-570W. The client is a PC-based program 

named DCON_Utility.exe running on PC.  

 

Step 1: Run the DCON firmware on the MP-570W controller 
 

 

The DCON firmware is located at: 

\System_Disk\Tools\DCON_CE\ 

 

 

 

 

 

Step 2: Run the DCON Utility on the host PC 

 

 

 

 

 

The DCON Utility can be obtained from: 

CD:\Napdos\vp-2000_ce50\PC_Tools\DCON_Utility\ 

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/pc_tools/dcon_utility/ 

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/pc_tools/dcon_utility/
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Step 3: Click the WIN CE button 

 

 

 

 

 

 

 

 

 

Step 4: On the WINCE device connection, enter the IP address of the 

MP-570W to search the I-87K series expansion I/O modules 
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Step 5: It will display a list of I-87K series expansion I/O modules, then 

select the module name that you want to configure 
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2.8. Using Backup Utility to Backup the settings and files 

After saving the configuration settings for a MP-570W device following the first use, it 

is recommended to use the backup utility to back up all the settings and files. 

 

Step 1: Run the backup_utility on the MP-570W 

The backup_utility is located at: 

\System_Disk\Tools\Backup_utility\ 

 

Step 2: Click the Backup menu 

 

 

 

 

 

 

 

 

 

 

Step 3: Select the options that you 

want to backup, enter text 

annotations and then click 

the Start backup button 
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Step 4: Confirm the backup 

options and then click 

Yes button 

 

 

 

 

Step 5: Choose the folder that 

you want to save backup 

file and click the Ok 

button 

 

 

 

 

Step 6: Wait for process to 

finish 
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2.9. A caution about using System_Disk 

The System_disk is an authoritative storage device, but is not suitable for frequent 

copying and deleting of files and is only suitable for storing important files that are not 

changed frequently. 

If files are copied and deleted frequently, the system will automatically perform a 

System_Disk defragment action, which will consume the total resources of the CPU 

and cause the OS not to function correctly. 

When the OS System_Disk defragment action is being performed, the run LED will 

blink and the defragment action icon will show in the system tray in the bottom 

right-hand of the pc screen. 

 

Tips & Warnings 

Don not power off the MP-570W while the defragment is being 

performed. 
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3. Tools and Tasks 

This chapter briefly describes the functions of the MP-570W tools and utilities. 

There are several tools and utilities built-in and designed for use with MP-570W. 

Some of these tools and utilities are installed on the MP-570W controller, some are 

available on PC. 

Both the tools and utilities of the MP-570W side and PC side tools can be found 

separately on the CD that was provided with the package or by downloading the 

latest version from ICP DAS web site. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

CD:\Napdos 

vp-2000_ce50 

System_Disk 

Tools 

DCON_CE 

ISQLW35 

Modbus 

NAPOPC_CE5 

RegistryViewer 

Remote_display_application 

SendToCOM 

TaskMgr 

VCEP 

ViewPAC_Utility 
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 DCON_CE 
 

With Host PC running the DCON Utility, on the MP-570W, the DCON_CE 

program allows user to view and monitor the status of the DCON Utility. 

 ISQLW35 
 

The ISQLW35 implements SQL server compact 3.5 Query Analyzer. 

 Modbus 
 

The Modbus provides various applications of Modbus protocol for configuring 

the MP-570W. 

 NAPOPC_CE5 
 

NAPOPC_CE5 is an integrated omnibus software package, it allows user to 

quickly establish a DCS control system. 

For more information about the NAPOPC_CE5, please refer to “3.2. 

NAPOPC_CE5”. 

 RegistryViewer 
 

The Registry Viewer allows user to view the registry value of Windows CE 

Operating System. 

 Remote display application  
 

The remote display application allows user to view the display remotely of the 

MP-570W on a Host PC. 
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 SendToCOM 
 

The SendToCOM allows user to send/receive data to/from the expansion 

module via serial port. 

 TaskMgr 
 

The TaskMgr provides details about programs and processes running on the 

MP-570W. 

 VCEP 
 

The VCEP allows user to manage the MP-570W remotely on a Host PC. 

For more information about the VCEP, please refer to “3.4. VCEP (Virtual CE 

Pro)”. 

 ViewPAC_Utility 
 

The ViewPAC_Utility provides various useful functions such as configuring 

Ethernet settings, monitoring system settings and FTP services .etc for easy and 

quick management. 
 

For more information about the ViewPAC_Utility, please refer to “3.5. 

ViewPAC_Utility”. 
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3.1. DCON Utility 

 

The DCON Utility is a tool kit that help user search the network, easily to Configure 

the I/O modules and test the I/O status via the serial port (RS-232/485) or Ethernet 

port (using virtual com port). It supports not only the DCON Protocol I/O modules but 

also the M Series I/O Modules (Modbus RTU M-7K, M-87K and will support Modbus 

ASCII M-87K) now. 

 

For more detailed information on DCON Utility applications, please refer to 

“2.7. Using DCON Utility to configure the I/O modules” 
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3.2. NAPOPC_CE5 

NAPOPC_CE5 DA Server is a free OPC DA Server (The "OPC" 

stands for "OLE for Process Control" and the "DA" stands for " 

Data Access") working on WinPAC, ViewPAC & WinCon 

controllers provided by ICP DAS Ltd. The first standard (originally 

called simply the OPC Specification and now called the Data 

Access Specification) resulted from the collaboration of a number of leading 

worldwide automation suppliers working in cooperation with Microsoft. Originally 

based on Microsoft's OLE COM (component object model) and DCOM (distributed 

component object model) technologies, the specification defined a standard set of 

objects, interfaces and methods for use in process control and manufacturing 

automation applications to facilitate interoperability. NAPOPC_CE5 DA Server 

integrates OPC, Modbus TCP Slave and Modbus RTU Slave three kind Slave 

services, as well as integrates Modbus TCP Master, Modbus RTU Master and DCON 

three kind Master communication protocols. It also provides one advanced function 

“Rule Script” for use in the I/O integration and transformation, and some conditional 

Logic operation. 

 

Any version before 2.1.0 of the NAPOPC_CE5 was named “Quicker” 
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3.3. SendToCOM 

The SendToCOM uses the serial port to communicate with expansion module. To use 

the SendToCOM, you can send data to expansion module through the serial port, and 

receive data from other device through the serial port. 

 

For more information about these commands for communicating with expansion 

module, please refer to: 

CD:\Napdos\io_module\87k_high_profile_modules.htm 
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3.4. VCEP 

 

 

 

 

 

 

 

ICPDAS VCEP is designed for managing your MP-570W anywhere. No matter where 

you are, ICPDAS VCEP provides a convenient environment on the Desktop PC and 

allows you control your MP-570W remotely. 

 

ICPDAS VCEP is composed of two main components: 

The “Server” which runs on MP-570W. 

The “Client" which runs on a Desktop PC. 

 

Once a connection is established between the client and server (initiated by the 

client), the client will periodically send requests for screen updates and send 

mouse/key click information to the server to simulate. Each video frame is 

inter-compressed against the previous frame and then intra-compressed with a 

modified LZW scheme to minimize the amount of data transmitted from server to 

client. 

 

For more detailed information on VCEP application, please refer to 

http://www.icpdas.com/products/PAC/wincon-8000/wincon_VirtualCE.htm 

 

http://www.icpdas.com/products/PAC/wincon-8000/wincon_VirtualCE.htm
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3.5. ViewPAC_Utility 

The ViewPAC_Utility is a tool which is designed to quickly control and management 

the MP-570W. 
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3.5.1. Menu Bar 

The ViewPAC_Utility includes the following function menu. All function menus will be 

explained later. 

 

 File Menu 

 

 

 Help Menu 

 

 

 Configuration Menu 

 

 

 



 

MP-570W User Manual, version 1.0.1.   Last Revised: August 2012   Page: 53 

Copyright ©  2012 ICP DAS Co., Ltd. All Rights Reserved.   E-mail: service@icpdas.com 

 

File Menu 

 

 

 

The menu commands Use to 

Save Saves the settings into Flash. 

The new settings don’t take effect until the 

MP-570W restart. 

Save and Reboot Saves the settings into Flash and restart the 

MP-570W. 

The new settings will take effect after the 

MP-570W restart. 

Reboot Without Save Restarts the MP-570W without save the settings 

into Flash. 

Restore Default 

Settings 

Restarts the settings of MP-570W to its factory 

default values. 

The settings include configuration setting, 

network setting, auto execution, etc. 

Exit Exits the ViewPAC_Utility. 
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Help Menu 

 

 

 

The menu commands Use to 

Reset System to 

Default 

Resets the system interrupt status to default. 

The operation used in the situation when the 

interrupt crash. 

You can select this operation to reset the 

interrupt status without rebooting the device. 

Release Notes Checks out what’s new and the know issues. 

About Displays a dialog box with information about 

ViewPAC_Utility, including the current version 

and copyright information. 
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Configuration Menu 

 

 

 

The menu commands Use to 

Import Registry Key Backs up a sub-key of registry by using a 

registration entry (.reg) file. 
 

How to use: 

Step 1: Select the “Import Registry Key”, then the 

“Open” dialog box will appear 

Step 2: On the “Open” dialog box, select a 

specific .reg file to import 
 

Warning: 

1. The .reg file which should be saved by “Export 

Registry Key”. 

2. It will not save automatically after import a .reg 

file. 

Export Registry Key Makes a back up of a registry sub-key 
 

How to use: 

Step 1: Select the “Export Registry Key”, then the 

“Export Registry” box will appear 

Step 2: Select a specific root key 

Step 3: Input a specific path of sub-key 

Step 4: Push the “OK” button, then the “Save As” 

dialog box will appear prompting you to select a 

location where you want to save this exported file 
 

Warning: 

The export operation will export all the sub-keys of 

the specific key which you input. 

Store All Registry Stores all registry setting to flash from .das file which 
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The menu commands Use to 

Setting is saved by “Dump All Registry Setting”. 
 

How to use: 

Step 1: Select the “Store All Registry Setting” , then 

the “Open” dialog box will appear 

Step 2: On the “Open” dialog box, select a 

specific .das file to store 
 

Warning: 

1. The .das file which should be saved by “Dump All 

Registry Setting”. 

2. It will save automatically after store .das file. 

Dump All Registry 

Settings 

Dump all registries setting to .das file. 
 

How to use: 

Select the “Dump All Registry Setting”, then the 

“Save As” dialog box will appear prompting you to 

select a location where you want to save this 

exported file. 
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3.5.2. Property Tabs 

The ViewPAC_Utility includes the following property tabs, all property tabs will be 

explained later. 

 

 

 

 

 

 

 

 

 

 

 

 

 System Setting 

 Ethernet Setting 

 Network Setting 

 System Information 

 Auto Execution 

 Multi-serial port wizard 

 System Memory Setting 

 Backplane Compatibility 
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System Setting Tab 

 

The System tab provides functions to configure the task bar HTTP directory path. 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Adjust the size of the desktop Select a display resolution from the 

Resolution list. 

Lock or Auto-Hide the taskbar Auto-Hide:  

Select the Auto Hide check box 

Lock:  

Select the Always On Top check box. 

Check the status of the battery See the Battery1 and Battery2 field that 

displays the battery status. 

Change the HTTP directory path Enter a new path in the Change HTTP 

document root directory 

\windows\www\wwwsub to field, and 

then press the Setting button. 
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Ethernet Setting Tab 

 

The Ethernet Setting tab provides functions to configure either DHCP (Roaming) 

or manually configured (Static) network settings and to monitor the MAC address. 

Generally, DHCP is the default settings, but if you don’t have a DHCP server, you 

must configure the network settings by using manual configuration. 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Configure the network 

settings 

Obtaining an IP address automatically from DHCP: 

Select the Use DHCP to get IP address option, and 

then press the Setting button. 

Manually assign an IP address: 

Select the Assign IP address option, and then press 

the Setting button. 

Monitor the MAC 

address 

See the MAC Address 1 fields that display the 

physical address of LAN1. 

Set up the i-8135 

Ethernet module driver 

See the next page. 
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8135 tab 

 

This tab provides functions to set up the i-8135 Ethernet module driver. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Set up the i-8135 network 

settings 

Obtaining an IP address automatically from 

DHCP: 

Select the Use DHCP to get IP address option, 

and then press the Setting button. 

Manually assign an IP address: 

Select the Assign IP address option, and then 

press the Setting button. 
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Network Setting Tab 

 

The Network tab consists of two tabs, Access and Login, which provides functions 

to enable/disable the FTP access, enable/disable anonymous FTP access, 

configure the FTP directory path, change HTTP document root directory and 

maintain the FTP accounts. 
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FTP Settings tab 

 

This tab provides functions to enable/disable the FTP access, enable/disable 

anonymous FTP access, and configure the FTP directory path. 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Enable or disable the 

FTP access 

Enable: Select the Enable check box in the FTP field. 

Disable: Select the Disable check box in the FTP field. 

Enable or disable 

anonymous FTP 

access 

Enable: Select the Enable check box in the Allow 

Anonymous field. 

Disable: Select the Disable check box in the Allow 

Anonymous field. 

Enable or disable 

anonymous FTP 

upload 

Enable: Select the Enable check box in the Allow 

Anonymous Upload field. 

Disable: Select the Disable check box in the Allow 

Anonymous Upload field. 

Change the FTP 

directory path 

Enter a new path in the Change FTP default download 

directory field, and then press the Setting button. 
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Users and Password tab 

 

This tab provides functions to maintain the FTP accounts. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Maintain the 

FTP accounts 

Refer to the Appendix C.1 How to add a user account to 

remote login the MP-570W from PC. 
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System Information Tab 

 

The System Information tab provides functions to monitor necessary system 

information. The system information is the most important note of version control 

for upgrading system. 
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Auto Execution Tab 

 

The Auto Execute tab provides functions to configure programs running at 

MP-570W startup, it allows users to configure ten execute files at most. 

Tips & Warnings 

The allowed file types are .exe and .bat, and they are executed in 

order of program 1, program 2, etc. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Configure programs 

running at startup 

Press the Browse button to select the execute file 

which you want, and then press the Setting button. 
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Multi-Serial Port Wizard Tab 

 

The Multi-serial port provides functions for installation of the 

RS-232/RS-422/RS-485 communication module driver. 

The table below shows the expansion 

RS-232/RS-422/RS-485 communication 

modules that are compatible with the 

MP-570W. 

 

Item RS-232 RS-422/RS-485 Isolation Connector 

I-8112iW 2 - 2500 Vrms DB-9 x 2 

I-8114W 4 - - DB-37 x 1 

I-8114iW 4 - 2500 Vrms DB-37 x 1 

I-8142iW - 2 2500 Vrms Terminator block x 1 

I-8144iW - 4 2500 Vrms Terminator block x 1 

The MP-570W can be expanded to support up to 16 I/O modules. 

For more detailed information about these support modules, please refer to 

http://www.icpdas.com/products/Remote_IO/i-8ke/selection_rs232_i8k.htm 

 

 

 

 

 

 

 

 

 

 

 

http://www.icpdas.com/products/Remote_IO/i-8ke/selection_rs232_i8k.htm
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Key Property Tab 

 

The Key Property tab provides functions to specify the programmable key to 

launch any program that you wish. 

Tips & Warnings 

The allowed file types are .exe and .bat. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Specify the 

programmable key to 

launch the program 

Press the … button to select the execute file which 

you want, select the Enable check box, and then 

press the Setting button. 

Specify the 

programmable key to 

control backlight 

Select the F6 control backlight check box, and 

then press the Setting button. 
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System Memory Tab 

 

The SRAM Setting tab provides functions to adjust and monitor the unused RAM.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Adjust display Move the slider left to release more memory 

running programs or move the slider right to release 

more storage room, and then press the Setting 

button 
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4. Your First MP-570W Program 

This chapter describes the components of the MP-570W SDK, and provides step by 

step tutorial for developer that will teach you how to create your first MP-570W 

program. 

 

Before writing your first program, ensure that you have the necessary development 

tools and the corresponding MP-570W SDKs are installed on your system. 

 

 



 

MP-570W User Manual, version 1.0.1.   Last Revised: August 2012   Page: 70 

Copyright ©  2012 ICP DAS Co., Ltd. All Rights Reserved.   E-mail: service@icpdas.com 

 

4.1. Preparing the Development Tools 

There are several programming tools available for application developers targeting 

Windows CE-based MP-570W. One of the following tools must be installed on the 

Host PC. 
 

 Microsoft eMbedded Visual C++ 

 Visual Basic.net  

 Visual C# 

 

 

4.2. Installing MP-570W SDKs 

The MP-570W SDK is a Software Development Kit (SDK) that contains C header files, 

C libraries and documents. 

Below is a step by step procedure for installing the MP-570W SDKs. 

 

Step 1: Insert the CD into your CD-ROM drive 

Step 2: Execute the “PAC270_SDK_YYYYMMDD.msi” which is located in 

CD:\Napdos\wp-8x4x_ce50\SDK\ 

Step 3: Follow the prompts until the installation is complete 
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4.3. Understanding the MP-570W APIs 

The MP-570W SDKs includes several application programming interfaces (APIs) that 

allows you perform various supporting tasks when developing MP-570W. 

 

 Requirements 

The MP-570W SDKs only supports NET Framework 2.0 or above. 

 Installation Path 

After installing the MP-570W SDKs, a number of functions can be installed on the 

Host PC, and this installation puts the header files, libraries into the following 

public places so they are easily changed by update the MP-570W SDKs. 

 

Header files: 

C:\Program Files\Windows CE Tools\wce500\PAC270\Icpdas\Include\ARMV4I\ 

Libraries: 

C:\Program Files\Windows CE Tools\wce500\PAC270\Icpdas\Lib\ARMV4I\ 
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4.3.1. MP-570W SDK Overview 

4.3.1.1. WinPAC Standard API 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

System Operation 

 System Information 

 Backplane Access 

 Interrupt 

 Memory Access 

PAC_IO 

Remote I/O Local I/O 

 Watchdog 

 UART 

 Registry 

 Micro SD 
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 SystemInformation Functions 

Provides reference information for the system status. 

 

 Backplane Access API 

Provides reference information for the backplane access APIs, including Hot Plug 

and backplane information.  

 

 Interrupt API 

Provides reference information for the Interrupt APIs  

 

 Memory Access API 

Provides reference information for the memory R/W APIs, including EEPROM and 

SRAM.  

 

 Watchdog Functions 

Provides reference information for the watchdog APIs, including hardware 

watchdog and OS watchdog. 

 

 UART API 

Provides reference information for the UART APIs. 

 

 Registry API 

Provides reference information for the registry.  

 

 microSD Management API 

Provides reference information for the microSD Manager. 
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 PAC_IO API 

Provides reference information for IO APIs, including local and remote. 

In additions, no matter 8K or 87K modules use the same API. 

 

 Error Handling API 

Provides reference information for error handling. 
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4.3.1.2. ViewPAC Particular API 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Backlight Functions 

Provides reference information for the backlight. 

 

 Buzzer Beep Functions 

Provides reference information for the buzzer. 

 

 LED Functions 

Provides reference information for the LED  

 

 Backlight 

 Buzzer Beep 

 LED 
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4.3.2. MP-570W SDK Reference 

For full usage information regarding the description, prototype and the arguments of  

the functions, please refer to the “WinPAC Standard API Manual” and “ViewPAC 

Particular API Manual” located at: 

CD:\Napdos\vp-2000_ce50\Document\SDK_Document\ 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/document/sdk_document/ 

 

 WinPAC Standard API Manual 

 

 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/document/sdk_document/
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 ViewPAC Particular API Manual 
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4.4. Your First Program in C# 

To create a demo program with C# development tool includes the following main 

steps: 

 

1. Create a new project 

2. Add project reference for an application 

3. Design and Build an application program 

4. Execute the application on the MP-570W 

 

All main steps will be described in the following subsection. 
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4.4.1. Create a new project 

Step 1: Start the Visual Studio 2005 

 

Step 2: On the “File” menu, select the “New” command, and then click the 

“Project” command 
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Step 3: In the “New Project” dialog box do the following in this order 
 

 

 

Step 4: Click OK to start creating a “SDKinfo” project 
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4.4.2. Add project reference for an application 

Step 1: On the “Solution Explorer” window, right-click the “Reference” 

and then click the “Add Reference…” command 

 

 

Step 2: In the “Add Reference” 

dialog box, select the 

“Browse” tab, and 

then specify the 

directory of the 

“ViewPacNet.dll” file 

in the “File name” 

field 

 

The “ViewPacNet.dll” file can be obtained from: 

CD:\Napdos\vp-2000_ce50\SDK\ViewPacNet\ 

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/sdk/viewpacnet/ 

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/sdk/viewpacnet/
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4.4.3. Design and Build an application program 

Step 1: Add a “button” object in the “From1” dialog box 

 

Step 2: Right-click the “button” object and click the “Properties” 

command 
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Step 3: On the “Properties” window, type “Check the SDK version” in the 

“Text” edit box 

 

 

 

Step 4: Right-click the “Form1” dialog box and click the “View Code” 

command to open the editor window 
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Step 5: Insert the “using ViewPACNet;” into the header area after “using 

System.Windows.Forms;” 

 

 

Step 6: In the “Form1” dialog box, double-click the “button” object to 

open the editor window 
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Step 7: Insert the following code in the Editor Window 

 

MessageBox.Show(pac_GetVIEWSDKVersion()); 
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4.4.4. Execute the application on the MP-570W 

Step 1: On the “Build” menu, click the “Build Solution” command 

 

 

Step 2: Open the web browser and type the IP address to connect the FTP 

server of MP-570W 

 

Step 3: Upload the “SDKinfo.exe” application and the corresponding 

“ViewPacNet.dll” file to the MP-570W via the MP-570W FTP server 
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Tips & Warnings 

For applications programming in C# and VB.net with .net 

framework, when executing these application on the 

MP-570W controller, the corresponding “ViewPacNet.dll” file 

must be in the same directory as the .exe file 

 

 

 

Step 4: On the MP-570W, execute the uploaded file 
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4.5. Your First Program in VB.net 

To create a demo program with C# development tool includes the following main 

steps: 

 

1. Create a new project 

2. Add project reference for an application 

3. Design and Build an application program 

4. Execute the application on the MP-570W 

 

All main steps will be described in the following subsection. 
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4.5.1. Create a new project 

Step 1: Start the Visual Studio 2005 

 

Step 2: On the “File” menu, select the “New” command, and then click the 

“Project” command 

 

 

 

 

 

 

 

 

 

 

Step 3: In the “New Project” dialog box do the following in this order 
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Step 4: Click OK to start creating a “SDKinfo” project 
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4.5.2. Add project reference for an application 

Step 1: On the “Class View” window, right-click the “Reference” and then 

click the “Add Reference…” command 

 

 

 

Step 2: In the “Add Reference” 

dialog box, select the 

“Browse” tab, and then 

specify the directory of the 

“ViewPacNet.dll” file in the 

“File name” field 

 

 

 

The “ViewPACNet.dll” file can be obtained from: 

CD:\Napdos\vp-2000_ce50\SDK\ViewPacNet\ 

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/sdk/viewpacnet/ 

 

 

 

  

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/sdk/viewpacnet/
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4.5.3. Design and Build an application program 

Step 1: Add a “button” object in the “From1” dialog box 

 

Step 2: Right-click the “button” object and click the “Properties” 

command 
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Step 3: On the “Properties” window, type “Check the SDK version” in the 

“Text” edit box 

 

 

 

Step 4: In the “Form1” dialog box, double-click the “button” object to 

open the editor window 
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Step 5: Insert the following code in the Editor Window 

 

1. Imports ViewPacNet 

2. MessageBox(ViewPacNet.pac_GetOSVersion()) 

 

 

 

1 

2 
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4.5.4. Execute the application on the MP-570W 

Step 1: On the “Build” menu, click the “Build Solution” command 

 

 

Step 2: Open the web browser and type the IP address to connect the FTP 

server of MP-570W 

 

Step 3: Upload the “SDKinfo.exe” application and the corresponding 

“ViewPacNet.dll” file to the MP-570W via the MP-570W FTP server 
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Tips & Warnings 

For applications programming in C# and VB.net with .net 

framework, when executing these application on the 

MP-570W controller, the corresponding “ViewPacNet.dll” file 

must be in the same directory as the .exe file 

 

 

 

Step 4: On the MP-570W, execute the uploaded file 
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4.6. Your First Program in eMbedded Visual C++ 

To create a demo program with eMbedded Visual C++ development tool includes the 

following main steps: 

 

1. Create a new Forms-Based project 

2. Configure compiler options 

3. Design and Build an application program 

4. Execute the application on the MP-570W 

 

All main steps will be described in the following subsection. 
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4.6.1. Create a new Forms-Based project 

Step 1: Start the Microsoft Embedded Visual C++ 

 

Step 2: From the “File” menu, click the “New” command 
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Step 3: In the “New” dialog, select the “Projects” tab and do the following 

in this order 
 

 

Tips & Warnings 

The selected CPU type must have “Win32 [WCE ARMV4I]” 

 

 

 

Step 4: Click the “OK” button to start the wizard 
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Step 5: On the first page of the wizard, select “Dialog based” option and 

then click the “Next” button to the next step 

 

 

Step 6: On the next page of the wizard, leave all the options as they are, 

and then click the “Next” button to the next step 
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Step 7: On the next page of the wizard, leave all the options as they are, 

and then click the “Next” button to the next step 

 

 

 

Step 8: On the next page of the wizard, leave all the options as they are, 

and then click the “Finish” button to complete the wizard 
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Step 9: The final summary appears, click the “OK” button to exit the 

wizard 
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4.6.2. Configure compiler options 

On the WCE configuration toolbar, select the “Win32 [WCE ARMV4] 

Release” 
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4.6.3. Specify the path for project reference 

Step 1: Click the “Options…” command from the “Tools” menu 
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Step 2: In the “Option” dialog, select the “Directories” tab and do the 

following in this order to specify the header file include path  
  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The “ViewPacSdk.h” file can be obtained from: 

CD:\Napdos\vp-2000_ce50\SDK\ViewPACSDK\ 

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/sdk/viewpacsdk/ 

 

 

 

 

 

 

 

 

 

Click this button 

to specify the 

header file 

include path 

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/sdk/viewpacsdk/
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Step 3: In the “Option” dialog, select the “Directories” tab and do the 

following in this order to specify the library file path  
  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The “ViewPacSdk.lib” file can be obtained from: 

CD:\Napdos\vp-2000_ce50\SDK\ViewPacSdk\ 

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/sdk/viewpacsdk/ 

 

 

 

 

 

 

 

 

 

 

Click this button 

to specify the 

library file path 

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/sdk/viewpacsdk/
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Step 4: Click the “Settings…” command from the “Project” menu 

 

 

Step 5: In the “Project Settings” dialog box do the following in this order 
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4.6.4. Design and Build an application program 

Step 1: On the “Workspace” window, select the “ResourceView” tab and 

expand the “dialog” folder, and then double-click the 

“IDD_DEMO_DIALOG” to open the dialog box 

 

 

Step 2: Add the “button” object in the “SDKinfo” dialog box 
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Step 3: In the “SDKinfo” dialog box, right-click the button object and then 

click the “Properties” command 

 

 

Step 4: Type the “Check the SDK version” in the “Caption” edit box and 

then click the “close” button 
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Step 5: In the “SDKinfo” dialog box, double-Click the button object 

 

 

Step 6: Type the “OnBtnCheckSDK” in the “Member function name” edit 

box and then click the “OK” button 
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Step 7: Insert the following code into the Editor Window 
 

char SDK[32]; 

TCHAR buf[32]; 

pac_GetVIEWSDKVersion(SDK); 

pac_AnsiToWideString(SDK, buf); 

MessageBox(buf,NULL,MB_OK); 
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Step 8: Insert the “#include “Viewpacsdk.h” and #include “winpacsdk.h”” 

into the header area 
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4.6.5. Execute the application program on MP-570W 

Step 1: On the “Build” menu, click the “Build systeminfo.exe” command 

 

 

Step 2: Open the web browser and type the IP address to connect the FTP 

server of MP-570W 

 

Step 3: Upload the “SDKinfo.exe” application to the MP-570W via the 

MP-570W FTP server 

 

Step 4: On the MP-570W, execute 

the uploaded file 
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5. APIs and Demo References 

This chapter introduces demo programs that have been designed for the MP-570W. 

You can examine the demo source code, which includes numerous comments, to 

familiarize yourself with the MP-570W APIs. This will allow developing your own 

applications quickly by modifying these demo programs. The following details the 

contents of the MP-570W demo programs. 
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5.1. Demo programs with C# 

The table below describes the MP-570W demos that have been designed to 

demonstrate the standard operation features of the MP-570W. 

 

5.1.1. C# Demo program for WinPAC Standard API 

The table below describes the MP-570W demos that have been designed to 

demonstrate the standard operation features of the MP-570W. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

System Operation 

 System Information 

 Backplane Access 

 Interrupt 

 Memory Access 

 Watchdog 

 UART 

 Registry 

 Micro SD 
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Folder Demo Explanation 

system systeminfo 

Retrieves information about the 

OS version, CPU version, SDK 

version, etc. 

backplane backplaneinfo 

Retrieves information about the 

DIP switch, backplane ID and 

slot count. 

memoryaccess 

memory 
Shows how to read/write date 

values from/to EEPROM 

battery_backup_sram 
Shows how to read or write to 

the battery backup 

watchdog watchdog 
Displays how the watchdog 

operate 

microsd microsd_management 
Shows how to enables/disables 

Micro SD 

registry registry 
Shows how to read/write date 

values from/to registry 

UART diag 
Shows how to read the name of 

local I/O modules via UART 

 

For C# application, these demo programs can be obtained from: 

CD:\Napdos\wp-8x4x_ce50\Demo\WinPAC\DOTNET\C#.NET\Standard 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/dotnet/

c%23.net/stand/ 

 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/dotnet/c%23.net/stand/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/dotnet/c%23.net/stand/
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5.1.2. C# Demo program for PAC IO API 

The table below describes the MP-570W demos that have been designed to 

demonstrate the expansion I/O module features of the MP-570W. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

PAC_IO 

Remote I/O Local I/O 
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Folder Demo Explanation 

Local 

find_io 
Shows how to retrieve the module names and 

types which plugged in the MP-570W. 

8k_di 

Shows how to read the DI values of DI module. 

This demo program is used by 8K series DI 

modules. 

8k_do 

Shows how to write the DO values to DO module. 

This demo program is used by 8K series DO 

modules. 

8k_dio 

Shows how to read the DI and the DO values of 

the DIO module.  

This demo program is used by 8K series DIO 

modules. 

87k_basic 

Shows how to send/receive a command/response 

application. 

This demo program is used by 87K series 

modules. 

87K_demo 

Shows how use UART API and the IO modules 

located as slots.  

This demo program is used by 87K series 

modules. 

87k_ai 

Shows how to read the AI values of AI module. 

This demo program is used by 87K series AI 

modules. 

87k_ao 

Shows how to write the AO values to AO module. 

This demo program is used by 87K series AO 

modules. 

87k_di 

Shows how to read the DI values of DI module. 

This demo program is used by 87K series DI 

modules. 

87k_do 

Shows how to write the DO values to DO module. 

This demo program is used by 87K series DO 

modules. 

87k_dio 

Shows how to read the DI and the DO values of 

the DIO module. 

This demo program is used by 87K series DIO 

modules. 
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Folder Demo Explanation 

Remote 

7k87k_basi

c 

Shows how to send/receive a command/response 

application. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_ai 

Shows how to read the AI values of AI module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_ao 

Shows how to write the AO values to AO module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_di 

Shows how to read the DI values of DI module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_do 

Shows how to write the DO values to DO module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_dio 

Shows how to read the DI and the DO values of 

the DIO module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

 

For C# application, these demo programs can be obtained from: 

CD:\Napdos\wp-8x4x_ce50\Demo\WinPAC\DOTNET\C#.NET\PAC_IO\ 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/dotnet/

c%23.net/pac_io/ 

 

 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/dotnet/c%23.net/pac_io/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/dotnet/c%23.net/pac_io/
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5.1.3. C# Demo program for MP-570W Particular API 

The table below describes the MP-570W demos that have been designed to 

demonstrate the particular features of the MP-570W. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Backlight 

 Buzzer Beep 

 LED 



 

MP-570W User Manual, version 1.0.1.   Last Revised: August 2012   Page: 121 

Copyright ©  2012 ICP DAS Co., Ltd. All Rights Reserved.   E-mail: service@icpdas.com 

 

 

Folder Demo Explanation 

BuzzerBeep BuzzerBeep 
Shows how to make a simple 

buzzer beep. 

KeyPad KeyPad Shows how the KeyPad operates. 

LCDBackLight LCDBackLight 
Shows how to control the LCD 

backlight. 

Led Led Shows how to control the LEDs. 

PlaySound PlaySound 
Shows how to control the 

microphone-in and earphone-out. 

 

For C# application, these demo programs can be obtained from: 

CD:\Napdos\vp-2000_ce50\Demo\ViewPAC\DotNET\C#.NET\ 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/demo/viewpac/dotnet

/c%23.net/ 

 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/demo/viewpac/dotnet/c%23.net/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/demo/viewpac/dotnet/c%23.net/
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5.2. Demo Programs with eMbedded Visual C++ 

Examples are good way to understand the MP-570W SDKs. The table below 

describes MP-570W demos and covers most of the common usages of each 

MP-570W API for using eMbedded Visual C++. 
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5.2.1. eVC Demo program for WinPAC Standard API 

The table below describes the MP-570W demos that have been designed to 

demonstrate the standard operation features of the MP-570W. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

System Operation 

 System Information 

 Backplane Access 

 Interrupt 

 Memory Access 

 Watchdog 

 UART 

 Registry 

 Micro SD 
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Folder Demo Explanation 

system systeminfo 

Retrieves information about the 

OS version, CPU version, SDK 

version, etc. 

backplane backplaneinfo 

Retrieves information about the 

DIP switch, backplane ID and 

slot count. 

memoryaccess 

memory 
Shows how to read/write date 

values from/to EEPROM 

battery_backup_sram 
Shows how to read or write to 

the battery backup 

watchdog watchdog 
Displays how the watchdog 

operate 

microsd microsd_management 
Shows how to enables/disables 

Micro SD 

registry registry 
Shows how to read/write date 

values from/to registry 

UART diag 
Shows how to read the name 

of local I/O modules via UART 

 

For eVC application, these demo programs can be obtained from: 

CD:\Napdos\wp-8x4x_ce50\Demo\WinPAC\eVC\Standard\ 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/evc/sta

ndard/ 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/evc/standard/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/evc/standard/
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5.2.2. eVC Demo program for PAC IO API 

The table below describes the MP-570W demos that have been designed to 

demonstrate the expansion I/O module features of the MP-570W. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

PAC_IO 

Remote I/O Local I/O 
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Folder Demo Explanation 

Local 

find_io 
Shows how to retrieve the module names and 

types which plugged in the MP-570W. 

8k_di 

Shows how to read the DI values of DI module. 

This demo program is used by 8K series DI 

modules. 

8k_do 

Shows how to write the DO values to DO module. 

This demo program is used by 8K series DO 

modules. 

8k_dio 

Shows how to read the DI and the DO values of 

the DIO module.  

This demo program is used by 8K series DIO 

modules. 

87k_basic 

Shows how to send/receive a command/response 

application. 

This demo program is used by 87K series 

modules. 

87K_demo 

Shows how use UART API and the IO modules 

located as slots.  

This demo program is used by 87K series 

modules. 

87k_ai 

Shows how to read the AI values of AI module. 

This demo program is used by 87K series AI 

modules. 

87k_ao 

Shows how to write the AO values to AO module. 

This demo program is used by 87K series AO 

modules. 

87k_di 

Shows how to read the DI values of DI module. 

This demo program is used by 87K series DI 

modules. 

87k_do 

Shows how to write the DO values to DO module. 

This demo program is used by 87K series DO 

modules. 

87k_dio 

Shows how to read the DI and the DO values of 

the DIO module. 

This demo program is used by 87K series DIO 

modules. 
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Folder Demo Explanation 

Remote 

7k87k_basi

c 

Shows how to send/receive a command/response 

application. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_ai 

Shows how to read the AI values of AI module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_ao 

Shows how to write the AO values to AO module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_di 

Shows how to read the DI values of DI module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_do 

Shows how to write the DO values to DO module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_dio 

Shows how to read the DI and the DO values of 

the DIO module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

 

For eVC application, these demo programs can be obtained from: 

CD:\Napdos\wp-8x4x_ce50\Demo\WinPAC\eVC\PAC_IO\ 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/evc/pa

c_io/ 

 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/evc/pac_io/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/evc/pac_io/
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5.2.3. eVC Demo program for MP-570W Particular API 

The table below describes the MP-570W demos that have been designed to 

demonstrate the particular features of the MP-570W. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Backlight 

 Buzzer Beep 

 LED 



 

MP-570W User Manual, version 1.0.1.   Last Revised: August 2012   Page: 129 

Copyright ©  2012 ICP DAS Co., Ltd. All Rights Reserved.   E-mail: service@icpdas.com 

 

 

Folder Demo Explanation 

BuzzerBeep BuzzerBeep 
Shows how to make a simple 

buzzer beep. 

KeyPad KeyPad Shows how the KeyPad operate. 

LCDBackLight LCDBackLight 
Shows how to control the LCD 

backlight. 

Led Led Shows how to control the LEDs. 

PlaySound PlaySound 
Shows how to control the 

microphone-in and earphone-out. 

 

For eVC application, these demo programs can be obtained from: 

CD:\Napdos\vp-2000_ce50\Demo\ViewPAC\eVC\ 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/demo/viewpac/evc/ 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/demo/viewpac/evc/
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6. MP-570W Updates 

This chapter provides instructions on how to upgrade MP-570W OS and SDK. 

ICP DAS will continue to add additional features to MP-570W SDK and OS in the 

future, so we advise you to periodically check the ICP DAS web site for the latest 

updates. 

 

MP-570W updates services can be divided into the following two main categories: 

 

 

 

 

CD: \Napdos 

vp-2000_ce50 

os_image 

vp-25w1 

SDK 

ViewPacNet 

ViewPacSdk 

1. OS updates 

2. SDK updates 
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6.1. OS updates 

The updates files of OS image are located on: 

CD:\Napdos\vp-2000_ce50\OS_image\vp-25w1\ 

 

 

 

 

 

 

 

 

 

 

 

 

 

CD: \Napdos 

vp-2000_ce50 

OS_image 

vp-25w1 

eboot 

update_from_eshell 

update_from_file 
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Upgrade 

There are two different ways of MP-570W OS image updates: 

i. MP-570W OS updates from file 

(We recommend that you use this method for quick and easy to update 

MP-570W OS image) 

ii. MP-570W OS updates from eshell 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

OS_image 

vp-25w1 

Update_from_files Update_from_eshell 

 SDK update 

Upgrade 
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The MP-570W OS supports multi-language: 
 

i. en- English 

ii. sc- Simplified Chinese 

iii. tc- Traditional Chinese 

 

 

os_image 

vp-25w1 

update_from_file 

en sc tc 

update_from_eshell 

en sc tc 
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6.1.1. Updating the Boot Loader and the MP-570W OS image from files 

There are two different ways of MP-570W OS image update: 

i. MP-570W OS updates from files (Please refer to this section) 

We recommend that you use this method for quick and easy to update the 

MP-570W OS image 

ii. MP-570W OS updates from eshell tool (Please refer to section “6.1.2. Updating the 

MP-570W OS image from eshell”) 

 

 

 

 

 
 
 

 

 

Step 1: Get the latest version of the execute file and the corresponding 

“autoinit.bat” file and run it on the MP-570W side 
 

Each folder contains an execute file and a corresponding “autoinit.bat” file. 

 

 

 

 

 

 

 

 

 

OS_image 

vp-25w1 

Update_from_files Update_from_eshell 
Upgrade 
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Step 2: Get the latest version of the installation package and download it 

to MP-570W, then execute it 

The latest version of the installation package can be obtained from:  

CD:\Napdos\vp-2000_ce50\os_image\vp-25w1\update_from_file\ 

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/os_image/vp-25w1/

update_from_file/ 

 

 

 

 

 

 

 

 

 

 

 

There are several ways to download the installation package to MP-570W: 

 On the MP-570W, you can download the installation package via an 

Ethernet connection. 

 On the host PC, you can download the installation package to MP-570W via 

a USB storage device, the removable Micro SD card or FTP server. 

 

The latest version of the MP-570W OS image file can be obtained from: 

CD:\Napdos\vp-2000_ce50\OS_image\vp-25w1\update_from_file\  

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/os_image/vp-25w1/u

pdate_from_file/ 

 

 

 

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/os_image/mp-570/update_from_file/
http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/os_image/mp-570/update_from_file/
http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/os_image/vp-25w1/update_from_file/
http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/os_image/vp-25w1/update_from_file/
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Step 3: After execute the installation package, the “Warning !” dialog will 

display, then click the “OK” button to start the update 

instructions 

 

Step 4: On the main dialog, click the “Update Now” button 

 

 

Step 5: On the “Warning !” dialog, click the “Yes” button 
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Step 6: On the main dialog, click the “Update Now” button to start 

installation 

 

Tips & Warnings 

Please never turn the MP-570W off during OS load. Besides 

we recommend you turn off all other application before 

updating. 
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The installation will perform the following tasks: 

 

 

 

 

 

 

 

 

 

 

 

 

 

i. Install Boot Loader file 

 

Important Warning 

Be careful, if the boot loader broken off in this step and 

cannot restart in safe mode, you have to send it back to us. 

 

ii. Erase flash disk 
 

iii. Install OS image 
 

iv. Set registry settings to default 

Tips & Warnings 

This step will reset the registry settings to default, all of your 

before settings will lost. 
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Step 7: After completing the above-mentioned tasks, the “Warning !” 

dialog will appear as follow, after clicking “OK” button to finish 

updating OS image, be sure the MP-570W at normal mode 

 

 

 

 

 

 

 

 

Step 8: Check the MP-570W OS version 
 

Start the ViewPAC_Utility, and then select the 

“System Information” tab to check the current 

OS version. 
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6.1.2. Updating the MP-570W OS image from eshell 

There are two different ways of MP-570W OS image update: 

i. MP-570W OS updates from files (Please refer to this section) 

We recommend that you use this method for quick and easy to update the 

MP-570W OS image 

ii. MP-570W OS updates from eshell tool (Please refer to section “6.1.2. Updating 

the MP-570W OS image from eshell”) 

 

 

 

 

 

 

 

 

 

 

 

 

By default, the OS update from Host PC to 

MP-570W via Ethernet. Therefore, to 

update the OS image, make sure Ethernet 

is connected to the PC. 

 

 

 

 

 

Upgrade 

OS_image 

vp-25w1 

Update_from_files Update_from_eshell 
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Step 1: Get the latest version of the MP-570W OS image 

The latest version of the installation package can be obtained from:  

CD:\Napdos\vp-2000_ce50\os_image\vp-25w1\update_from_Eshell\ 

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/os_image/vp-25w1/

update_from_Eshell/ 

 

 

 

 

 

 

 

 

 

 

 

Step 2: Run the ESHELL software on the Host PC 

 

ESHELL you can be obtained at: 
 

CD:\Napdos\wp-8x4x_ce50\PC_Tools\Eshell\ 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/pc_tools/eshell/ 

 

 

 

 

 

http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/os_image/vp-25w1/update_from_Eshell/
http://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/os_image/vp-25w1/update_from_Eshell/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/vp-2000_ce50/pc_tools/eshell/
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Step 3: Reboot the MP-570W at update OS mode 

Turn the rotary switch to “3”, and then reboot the MP-570W. 

 

 

 

 

 

 

 

 

 

 

 

 

Step 4: Select the device which you want to update the OS image 
 

After starting the ESHELL software, the “Select Device” dialog will appear, then 

select the device which you want. 
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Step 5: Select the latest version of the OS image 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 6: Once the procedure is completed, the “Warning !” dialog box will 

Appear on MP-570W screen as below shown, before clicking the 

“Yes” button, you must first turn the rotary switch 

to the “0” position 

 

 



 

MP-570W User Manual, version 1.0.1.   Last Revised: August 2012   Page: 144 

Copyright ©  2012 ICP DAS Co., Ltd. All Rights Reserved.   E-mail: service@icpdas.com 

 

Step 7: Check the MP-570W OS version 
 

Start the ViewPAC_Utility, and then select the 

“System Information” tab to check the current 

OS version. 
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6.2. SDKs Updates 

The updates files of SDK image are located on: 

CD:\Napdos\vp-2000_ce50\SDK\ 

 

 

 

 

By eVC and donet development tools, the MP-570W SDK installation is divided 

into the following two parts: 
 

 

By eVC and donet development tools, the WinPAC SDK installation is divided into 

the following two parts: 
 

i. WinPAC SDK updates for dotnet 

ii. WinPAC SDK updates for eMbedded Visual C++ 

 

 

CD: \Napdos 

vp-2000_ce50 

SDK 

ViewPacNet 

ViewPacSdk 
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6.2.1. WinPAC SDK updates for C# or VB.net 

To determine the SDK version that is compatibly running on the WinPAC, you can 

read the “Release Note” which is located under each SDK folder, these files provides 

important updated information for what we fixed and added. 

 

 

Step 1: Get the latest version of the C# or VB.net components 
 

The latest version of the C# or VB.net components can be obtained from:  

ftp://ftp.icpdas.com/pub/cd/WinPAC/napdos/wp-8x4x_ce50/sdk/winpacnet/ 

 

Step 2: Copy the latest version of DLL to Host PC and WinPAC 
 

The DLL files on Host PC are located at anywhere only the solution can 

reference it. 

The DLL files on WinPAC are located at the same directory as the .exe file. 

 

 

ftp://ftp.icpdas.com/pub/cd/WinPAC/napdos/wp-8x4x_ce50/sdk/winpacnet/
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6.2.2. WinPAC SDK updates for eMbedded Visual C++ 

To determine the SDK version that is compatibly running on the WinPAC, you can 

read the “Release Note” which is located under each SDK folder, these files provides 

important updated information for what we fixed and added. 

 

 

Step 1: Get the latest version of the eMbedded Visual C++ components 
 

The latest version of the eMbedded Visual C++ components can be obtained 

from:  

ftp://ftp.icpdas.com/pub/cd/WinPAC/napdos/wp-8x4x_ce50/sdk/winpacsdk/ 

 

 

Step 2: Copy the latest version of header files and libraries to Host PC 
 

The header files are located at:  

C:\Program Files\Windows CE Tools\wce500\PAC270\Include 

The libraries are located at:  

C:\Program Files\Windows CE Tools\wce500\PAC270\Lib 

 

Step 3: Copy the latest version of DLL files to WinPAC 
 

The DLL files are located at:  

\System_Disk\ICPDAS\System 

 

ftp://ftp.icpdas.com/pub/cd/WinPAC/napdos/wp-8x4x_ce50/sdk/winpacsdk/
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Appendix A. I-8K and I-87K Modules 

There are 3 slot options to expand local I/O. And the I/O modules can be parallel bus 

type (high profile I-8K series) and serial bus type (high profile I-87K series).  

 

The difference between them is 

 

Item I-8K Series I-87K Series 

Communication interface Parallel bus Serial bus 

Protocol - DCON 

Communication speed Fast Slow 

DI latched function - Yes 

Counter input (for digital input module) - Yes (100 Hz) 

Power on value - Yes 

Safe value - Yes 

Programmable slew-rate for AO module - Yes 
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Appendix B. Application of RS-485 Network 

The RS-485 length can be up to 4000 ft or 1.2 km over a single set of twisted–pair 

cables, if the RS-485 network is over 4000 ft or 1.2Km, the RS-485 repeater must be 

added to extend the RS-485 network. 

 

 

B.1. Basic RS-485 Network 

The basic component of the RS-485 network consist of a Master Controller (or using 

a PC as a host controller), and some RS-485 devices. 

 

Tips & Warnings 

If PC/Laptop has no COM port, you can use the I-7561 (USB to 

RS-485 converter) for connection between MP-570W and 

PC/Laptop. 

Before using the I-7561 converter, you must install the USB driver. 

The USB driver can be obtained from: 

ftp://ftp.icpdas.com/pub/cd/8000cd/napdos/7000/756x/ 

 

 

 

 

 

 

 

 

ftp://ftp.icpdas.com/pub/cd/8000cd/napdos/7000/756x/
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B.2. Daisy Chain RS-485 Network 

All RS-485 devices are wired directly to the main network, If the network is up to 1.2 

km, it will need a repeater (7510 series) to extend the network length. 
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B.3. Star Type RS-485 Network 

There are branches along the main network. In this case, it is better to have a 

repeater to isolate or filter the noise that is made by devices. 
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There is a better choice to use 7513 as a RS-485 hub on start type network. 
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B.4. Random RS-485 Network 

There are branches along the main wire. In this case, it is better to have a repeater to 

isolate or filter the noise that is made by devices. 
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B.5. Master/Slaves Settings 

There must be exist one master to have a jumper in the same network. In a 

master/slave application, “Master” is the default configuration of MP-570W. 

 

B.5.1. MP-570W as a Master (default) 

When one of MP-570W is set to the master mode, then all the other devices on the 

same network must be set to the slave mode. 

Set MP-570W to the master mode by adjusting the jumpers on the power board of 

MP-570W. Refer to the following figure: 
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B.5.2. MP-570W as a Slave: 

Set MP-570W to the slave mode by adjusting the jumpers on the power board of 

MP-570W. Refer to the following figure: 
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The maximum distance of RS-485 without using a repeater is 1,200 meters (4,000 

feet). You can extend that distance by adding an RS-485 Repeater every 1,200 

meters as shown below. 
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Appendix C. Tips – How to 

We will continue to add flexibility and support to the ViewPAC that always can be 

found at: 

http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/document/faq/general_io

_expansion/ 

 

The following sections will present several common application of ViewPAC. 

http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/document/faq/general_io_expansion/
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/document/faq/general_io_expansion/
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C.1. How to add a user account to remote login the MP-570W from PC 

C.1.1. How to add a user account 

Here are step by step instructions on how to add a user account. 

 

Step 1: Run the ViewPAC_Utility 

 

Step 2: On the Network tab, click 

Login tab, type the User 

Name and Password, and 

then click Add button 
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Step 3: The user has been added to the allowed under the remote login 

and included in the following list 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 4: On the File menu, click Save and Reboot for changes to take effect 
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C.1.2. How to Use telnet to remote login the MP-570W from PC 

Here are step by step instructions on how to use telnet to remote login the XPAC from 

PC. 

 

Step 1: On the PC, open a MS-DOS command prompt 

 

 

Step 2: At the command prompt, type “telnet (IP address)” 

 

 

 

 

 

 

 

 

 

1 

2. Type “cmd” 
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Step 3: The connection has been set up, and then type the name and 

password 

 

 

Step 4: The remote login has been completed 
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C.1.3. How to remove the user from the login list 

Here are step by step instructions on how to remote the user from the login list. 

 

Step 1: Click a user from the list which you want to remove, and the user 

will display in the field, and then press Delete to delete the user 

from the login list 
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Step 2: On the File menu, click Save and Reboot for changes to take effect 
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C.2. How to online debug MP-570W 

Debugging is a process that you use to find and resolve errors, or bugs, in a program. 

 

 

C.2.1. Debug MP-570W programs in EVC++ 

Step 1: On the “Tools” menu, click “Configure Platform Manager…” 

command 
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Step 2: On the “Windows CE Platform Manager Configuration” dialog, 

click the “Properties…” button 

 

 

Step 3: On the “Device Properties” dialog, click the “Configure…” button 
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Step 4: On the “TCP/IP Transport Configuration” dialog, select the “Fixed 

port” check box, and then click the “OK” button 

 

 

Step 5: On the “Windows CE Platform Manager Configuration” dialog, 

click the “Test” button 
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Step 6: The “Manual Server - Action” dialog will appear displaying a 

command line, before click the “OK” button to close dialog, turn 

to the MP-570W controller side to do the next two-steps 

 

 

Step 7: On the MP-570W controller side, select the “ Start” menu, 

and then click the “Run…” command  
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Step 8: On the “Run” dialog, type the command which displays in step 5 

and then click the “OK” button 

 

 

Step 9: Return to the Host PC side, on the “Manual Server – Action” dialog, 

click the “OK” button 
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Step 10: On the “Testing Device Connection” dialog, click the “OK” button 

 

 

Step 11: On the “Device Properties” dialog, click the “OK” button 
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Step 12: On the “Windows CE platform or device to configure” dialog, 

click the “OK” button 

 

 

Step 13: On the “Build” menu, select the “Start Debug” command and 

then click the “Go” command 
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Step 14: The “Manual Server - Action” dialog will appear displaying a 

command line, before click the “OK” button to close dialog, turn 

to the MP-570W controller side to do the next two-steps  

 

 

Step 15: On the MP-570W controller side, select the “ Start” 

menu, and then click the “Run…” command  
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Step 16: On the “Run” dialog, type the command which displays in step 5 

and then click the “OK” button  

 

 

Step 17: Return to the Host PC side, on the “Manual Server – Action” 

dialog, click the “OK” button 
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Step 18: On the “Manual Server - Action” dialog, click the “OK” button 

 

 

Step 19: Connection established. Then you can debug on line. 

 

Tips & Warnings 

If you want to quit the debugger and return to editing, you 

can click the “Stop Debugging “button from “Debug” menu 
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C.2.2. Debug MP-570W programs in Visual Studio 
2005/2008 

Debugging in Visual Studio 2005/2008 are provided by MP-570W OS image V 1.3.0.4 

or later. 

 

Step 1: Make sure the following file are listed with the matching version 

numbers 

 

Path File 

C:\Program Files\Common Files\Microsoft 

Shared\CoreCon\1.0\Bin 

1. ActiveSyncBootstrap.dll 

2. ConMan2.dll 

3. ConManPS.dll 

4. DesktopDMA.dll 

5. eDbgTL.dll 

6. TcpConnectionC.dll 

C:\Program Files\Common Files\Microsoft 

Shared\CoreCon\1.0\Bin\1033 

conmanui.dll 

C:\Program Files\Common Files\Microsoft 

Shared\CoreCon\1.0\Target\wce400\armv4i 

1. DeviceDMA.dll 

2. eDbgTL.dll 

3. TcpConnectionA.dll 

4. clientshutdown.exe 

5. CMAccept.exe 

6. ConmanClient2.exe 
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Step 2: If the version matches correctly and the entire file are there, copy 

the following files to MP-570W :\ System_Disk\ICPDAS\System 

folder 
 

 Clientshutdown.exe 

 ConmanClient2.exe 

 CMaccept.exe 

 eDbgTL.dll 

 TcpConnectionA.dll 

 

Step 3: On the “Project” menu, click “[Project Name] Properties…” 

command 
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Step 4: On the “SystemInfo*” tab, unselect “Deploy the latest version of 

the .NET compact Framework (includeing Service Packs)” check 

box 

 

 

Step 5: On the “Tools” menu, click “Options…” command 
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Step 6: On the “Options” dialog, select “PAC 270” from the “Show 

devices platform” list, and then click the “Properties…” button 

 

 

 

Step 7: On the “CAYMAN-ARMV4I_Release Properties” dialog, click the 

“Configure…” button 
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Step 8: On the “Configure TCP/IP Transport” dialog, select the “Use 

specific IP address” option and type the IP address of MP-570W, 

and then click the “OK” button 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 9: On the “CAYMAN-ARMV4I_Release Properties” dialog, click the 

“OK” button 
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Step 10: On the “Options” dialog, click the “OK” button 

 

 

 

Step 11: On the MP-570W controller side, run the “CommanClient2” and 

the “CMAccept.exe” applications which is located at: 

\System_Disk\ICPDAS\System 
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Step 12: On the “Tools” menu, click “Connect to Device…” command 

 

 

Step 13: On the “Connect to Device” dialog, select “PAC 270” from 

“Platform” list and then click the “Connect” button 
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Step 14: On the “Tools” menu, click “Connect to Device…” command 

 

 

Step 15: Connection established. Then you can debug on line. 
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FAQ: 

 

If the connection fails shown as follow, return to step 11 to do the action 

below 

 

 

Open the command prompt, run the 

“CommanClient2.exe/transport:tcpconnectiona.dll/property:port=

5000/id:Con” at: \System_Disk\ICPDAS\System, and then run the 

“CMAccept.exe” 
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C.3. How to recompile WinCon programs 

To recompile Wincon programs to run on MP-570W, certain components of the 

programs require adjustments that divides into two parts: 

 

1. Compiler old programs which ran on Wincon 8x3x and 8x4x 

2. Modify .vcp file to upgrade the old WinCon project 

 

Tips & Warnings 

In general, you only need to do part 1, after this, if the 

program still can’t be compiled to an application, the part 2 

just need to do. 
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C.3.1. Compiler old programs which ran on Wincon 8x3x and 8x4x 

Step 1: Open project which programmed in WinCon using eMbedded 

Visual C++ 

 

Step 2: On the “Build” menu, click “Configurations” command 

 

 

Step 3: Make sure the CPU type is “STANDARDSDK” 
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Step 4: On the “Configurations” dialog, click the “Add…” button 

 

 

Step 5: On the “Add Project Configuration” dialog, choose one of the CPU 

type and then click the “OK” button. 
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Step 6: On the “Project” menu, click “Settings…” command 

 

 

Step 7: On the “Project Settings” dialog, select the “Link” tab and change 

the value of the “Entry-point symbol” field, “WinMainCRTStarup” 

to “wWinMainCRTStartup”, 
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Step 8: After performing above-mentioned steps, build the project, your 

project should build success. If not, it will show error message as 

follow. Please continue with the following steps 

 

 

Step 9: On the “Project” menu, click “Settings…” command 

 

 

Step 10: On the “Project Settings” dialog, select the “Link” tab and 

change the value of the “Project Options” field, “ARM” to 

“THUMB”, and then built the project  
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C.3.2. Modify .vcp file to upgrade the old WinCon project 

Step 1: Open a text editor to modify the .vcp file  
 

Step 2: In the .vcp file, replace “0xa301” with “0xa501” 
 

Step 3: In the .vcp file, replace “ARMV4” with “ARMV4I” 
 

Step 4: In the .vcp file, replace “MACHINE:ARM” with “MACHINE:THUMB” 
 

Step 5: Save the .vcp file just edited 
 

Step 6: Open the old WinCon project and recompile it 
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C.4. How to use the printer 

MP-570W have ability to access the printer, you can connect to the printer via 

Ethernet network or USB. 

 

Tips & Warnings 

MP-570W only supports HP Laser Jet Printers which 

support PCL6 driver. The following printer support is 

released by HP 

● HP LaserJet 4000 series/HP LaserJet 4100 series 

● HP LaserJet 2100 series/HP LaserJet 2200 series 

● HP LaserJet 1200 

● HP LaserJet 3200/HP LaserJet 3300 

● HP LaserJet 4200 series/HP LaserJet 4300 series 

● HP LaserJet 5000 series/HP LaserJet 5100 series 

● HP LaserJet 8000 series 

● HP LaserJet 9000 series printers 

If you need the latest support of HP PCL6 printer, you can 

refer to following link 

http://h20000.www2.hp.com/bizsupport/TechSupport/Docu

ment.jsp?objectID=bpl04568 

 

  

http://h20000.www2.hp.com/bizsupport/TechSupport/Document.jsp?objectID=bpl04568
http://h20000.www2.hp.com/bizsupport/TechSupport/Document.jsp?objectID=bpl04568
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C.4.1. How to use network printer 

To use a shared network printer, please perform the following steps: 

 

Step 1: On the Host PC, check the name of the Host PC and the shared 

printer  
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Step 2: On the MP-570W, open a WordPad format file 

 

Step 3: On the MP-570W, open a WordPad format file 

 

 

 

Step 2: Set up the printer 

1. Printer: PCL Laser 

2. Port: Network 

3. Net Path: \\ServerName\PrinterName 

The “ServerName” is your PC’s name or 

IP. 

The “PrinterName” is your printer’s 

shared name of your PC 

4. Paper Size: Select the paper size 

 

 

file://ServerName/PrinterName
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C.4.2. How to use printer via USB 

To use a shared network printer via USB, please perform the following steps: 

 

Step 1: On the MP-570W, open a WordPad format file 

 

 

 

 

Step 2: Set up the printer 

1. Printer: Hewlett-Packard LaserJet 

2. Port: LPT1 

3. Paper Size: Select the paper size 
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C.5. How to use services tool 

The services tool can help you turn on, turn off and monitor the WinCE services. 

 

Step 1: Open a MS-DOS command prompt 
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Step 2: List all services 
 

[Syntax] services list 

 

Step 3: Type the commands to configure service  
 

[Syntax] services stop <services name> 

For example, turn on the “FTP” service: 

services stop FTP0: 
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Tips & Warnings 

For more information about using services tool, you just type 

“services help” 
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Appendix D. Revision History 

Revision Date Description 

1.0.1 August 2012 Initial issue 
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